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A.1 Hasil Karakterisasi SiC 

 

Gambar A.1 Pola Grafik XRD SiC 

 

 

Gambar A.2 Hasil Akhir Refinement SiC 
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A.2 Hasil Flotasi Kolom 

 Tabel A.1 Massa konsentrat dan tailing variasi ukuran partikel -100+150# 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 6,21 

180 0,75 

210 0,61 

240 0,39 

360 1,12 

480 0,49 

600 0,12 

820 0,16 

1000 0,08 

Tailing  85,62 

 

Tabel A.2 Massa konsentrat dan tailing variasi ukuran partikel -150+200# 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 1,25 

180 1,39 

210 0,49 
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240 0,75 

360 0,88 

480 0,35 

600 0,35 

820 0,43 

1000 0,22 

Tailing 86,22 

 

Tabel A.3 Massa konsentrat dan tailing variasi ukuran partikel -200+230# 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 0,85 

180 1,11 

210 0,61 

240 1,68 

360 3,98 

480 1,04 

600 1,34 

820 0,26 

1000 0,47 

Tailing 51,22 
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Tabel A.4 Massa konsentrat dan tailing variasi ukuran partikel -230# 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 15,13 

180 4,77 

210 8,60 

240 5,63 

360 0,65 

480 0,04 

600 0,07 

820 0,59 

1000 0,11 

Tailing 59,1 

 

Tabel A.5 Massa konsentrat dan tailing variasi dosis frother 20 ppm 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 4,20 

180 0,93 

210 1,64 

240 1,72 
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360 4,69 

480 0,99 

600 0,35 

820 0,41 

1000 0,11 

Tailing 81,94 

 

Tabel A.6 Massa konsentrat dan tailing variasi dosis frother 30 ppm 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 18,99 

180 4,09 

210 2,27 

240 2,99 

360 11,09 

480 3,67 

600 0,87 

820 0,30 

1000 0,59 

Tailing 44,56 
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Tabel A.7 Massa konsentrat dan tailing variasi dosis frother 40 ppm 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 36,54 

180 9,33 

210 2,70 

240 3,59 

360 0,98 

480 0,79 

600 0,42 

820 0,12 

1000 0 

Tailing 39,46 

 

Tabel A.8 Massa konsentrat dan tailing variasi dosis frother 50 ppm 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 15,13 

180 4,77 

210 8,60 

240 5,63 
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360 0,65 

480 0,04 

600 0,07 

820 0,59 

1000 0,11 

Tailing 59,1 

 

Tabel A.9 Grain counting variasi ukuran partikel -100+150# 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 
SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 
SiC 27 32 38 16 44 31 

SiO2 840 867 1500 761 1014 996 

180 
SiC 6 65 95 13 130 62 

SiO2 830 2153 843 392 1142 1072 

210 
SiC 47 25 57 82 289 100 

SiO2 1816 2158 2049 1075 2600 1900 

240 
SiC 8 3 13 35 36 19 

SiO2 265 661 327 549 118 384 
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360 
SiC 37 42 47 39 50 43 

SiO2 639 390 977 317 2357 936 

480 
SiC 41 4 4 60 57 33 

SiO2 988 443 1100 1590 1580 1140 

600 
SiC 17 12 14 44 21 22 

SiO2 938 420 652 609 1097 743 

820 
SiC 6 20 52 33 42 31 

SiO2 353 61 789 667 578 490 

1000 
SiC 23 50 3 9 57 28 

SiO2 645 186 482 274 219 361 

 

Tabel A.10 Grain counting variasi ukuran parikel -150+200# 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 
SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 
SiC 27 32 38 16 44 31 

SiO2 840 867 1500 761 1014 996 

180 
SiC 6 65 95 13 130 62 

SiO2 830 2153 843 392 1142 1072 
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210 
SiC 47 25 57 82 289 100 

SiO2 1816 2158 2049 1075 2600 1900 

240 
SiC 8 3 13 35 36 19 

SiO2 265 661 327 549 118 384 

360 
SiC 37 42 47 39 50 43 

SiO2 639 390 977 317 2357 936 

480 
SiC 41 4 4 60 57 33 

SiO2 988 443 1100 1590 1580 1140 

600 
SiC 17 12 14 44 21 22 

SiO2 938 420 652 609 1097 743 

820 
SiC 6 20 52 33 42 31 

SiO2 353 61 789 667 578 490 

1000 
SiC 23 50 3 9 57 28 

SiO2 645 186 482 274 219 361 

 

Tabel A.11 Grain counting variasi ukuran partikel -200+230# 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 SiC 0 0 0 0 0 0 
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SiO2 0 0 0 0 0 0 

150 
SiC 488 295 250 247 222 300 

SiO2 1310 893 1286 1208 2015 1343 

180 
SiC 25 64 129 120 74 82,4 

SiO2 472 303 955 445 496 534 

210 
SiC 38 55 16 53 84 49,2 

SiO2 523 583 236 243 249 367 

240 
SiC 165 45 189 172 288 172 

SiO2 997 874 986 1003 481 868 

360 
SiC 461 184 87 57 116 181 

SiO2 1819 900 1360 821 1001 1180 

480 
SiC 103 55 72 111 128 93,8 

SiO2 1157 789 1322 1493 662 1085 

600 
SiC 139 40 340 250 89 172 

SiO2 1100 1188 1272 1306 689 1111 

820 
SiC 11 21 7 169 29 47,4 

SiO2 607 119 920 465 345 491,2 

1000 
SiC 33 65 6 189 6 60 

SiO2 1084 260 405 653 121 504,6 
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Tabel A.12 Grain counting variasi ukuran partikel -230# 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 
SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 
SiC 138 73 212 106 62 118 

SiO2 720 734 1191 813 561 804 

180 
SiC 262 124 209 270 215 216 

SiO2 597 690 361 604 652 581 

210 
SiC 197 121 19 174 51 112 

SiO2 1370 729 842 752 260 791 

240 
SiC 161 180 631 43 200 243 

SiO2 947 788 2740 695 1213 1277 

360 
SiC 139 102 44 60 193 108 

SiO2 575 800 774 513 552 643 

480 
SiC 96 244 118 47 156 132 

SiO2 367 114 329 260 820 378 

600 
SiC 6 47 41 12 3 22 

SiO2 509 770 473 1469 959 836 

820 SiC 35 13 26 43 40 31 
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SiO2 579 759 562 603 652 631 

1000 
SiC 52 140 22 3 4 42 

SiO2 305 498 410 404 739 471 

 

Tabel A.13 Grain counting variasi dosis frother 20 ppm 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 
SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 
SiC 136 129 126 191 227 162 

SiO2 390 418 1339 911 655 743 

180 
SiC 207 214 169 195 197 196,4 

SiO2 464 417 485 414 321 420 

210 
SiC 314 255 220 231 375 279 

SiO2 1437 1186 894 1313 1283 1223 

240 
SiC 206 194 177 201 311 218 

SiO2 387 313 1365 720 1437 844 

360 
SiC 148 121 130 38 88 105 

SiO2 205 80 220 49 175 146 

480 SiC 53 59 149 78 120 92 
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SiO2 108 280 720 648 285 408 

600 
SiC 59 62 43 56 98 63,6 

SiO2 285 156 507 410 354 342 

820 
SiC 48 90 143 125 168 115 

SiO2 267 303 745 835 657 561,4 

1000 
SiC 267 171 501 506 108 311 

SiO2 2450 734 3461 935 207 1557 

 

Tabel A.14 Grain counting variasi dosis frother 30 ppm 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 
SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 
SiC 1198 415 665 474 692 689 

SiO2 3075 2064 2223 1246 944 1910 

180 
SiC 205 258 27 107 135 146,4 

SiO2 646 450 133 361 504 419 

210 
SiC 173 1146 1049 1521 1095 418,8 

SiO2 535 3906 3135 1989 4058 997 

240 SiC 351 490 1333 272 154 520 
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SiO2 1564 746 2542 478 1461 1358 

360 
SiC 79 77 213 65 320 150,8 

SiO2 1205 245 678 608 294 606 

480 
SiC 63 78 182 392 530 249 

SiO2 577 307 223 425 686 443,6 

600 
SiC 178 197 150 1836 235 519,2 

SiO2 128 227 743 1798 1015 782,2 

820 
SiC 86 70 35 164 17 74,4 

SiO2 238 249 246 471 79 256,6 

1000 
SiC 4 77 18 9 142 50 

SiO2 260 120 351 249 529 302 

 

Tabel A.15 Grain counting variasi dosis frother 40 ppm 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 
SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 
SiC 107 82 99 116 453 171,6 

SiO2 638 268 361 324 861 490,4 

180 SiC 195 110 147 53 204 141,8 
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SiO2 493 522 929 479 446 573,8 

210 
SiC 307 32 394 538 30 260,2 

SiO2 171 355 646 726 80 395,6 

240 
SiC 297 42 64 71 69 108,6 

SiO2 633 146 206 166 475 325,2 

360 
SiC 389 49 70 93 130 146,2 

SiO2 574 149 308 335 144 302 

480 
SiC 135 59 180 164 74 122,4 

SiO2 260 390 365 175 197 277,4 

600 
SiC 117 100 243 69 51 116 

SiO2 684 231 636 223 267 408,2 

820 
SiC 117 599 238 114 263 266,2 

SiO2 425 717 635 168 501 489,2 

1000 
SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

 

Tabel A.16 Grain counting variasi dosis frother 50 ppm 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 SiC 0 0 0 0 0 0 
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SiO2 0 0 0 0 0 0 

150 
SiC 138 73 212 106 62 118 

SiO2 720 734 1191 813 561 804 

180 
SiC 262 124 209 270 215 216 

SiO2 597 690 361 604 652 581 

210 
SiC 197 121 19 174 51 112 

SiO2 1370 729 842 752 260 791 

240 
SiC 161 180 631 43 200 243 

SiO2 947 788 2740 695 1213 1277 

360 
SiC 139 102 44 60 193 108 

SiO2 575 800 774 513 552 643 

480 
SiC 96 244 118 47 156 132 

SiO2 367 114 329 260 820 378 

600 
SiC 6 47 41 12 3 22 

SiO2 509 770 473 1469 959 836 

820 
SiC 35 13 26 43 40 31 

SiO2 579 759 562 603 652 631 

1000 
SiC 52 140 22 3 4 42 

SiO2 305 498 410 404 739 471 
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A.3 Hasil Monitoring Kapasitansi dari Kapasitometer CAP 3201 2CH C-

Tech Edwar Labs Technology 

Tabel A.17 Data kapasitometer variasi ukuran partikel -100+150# 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,515 2,867 945 3914 

150 2,515 2,871 945 3918 

180 2,515 2,894 945 3951 

210 2,411 2,909 906 3971 

240 2,411 2,918 906 3983 

360 2,411 2,915 906 3979 

480 2,515 2,891 945 3947 

600 2,515 2,901 945 3960 

820 2,411 2,915 906 3979 

1000 2,411 2,902 906 3961 
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Tabel A.18 Data kapasitometer variasi ukuran partikel -150+200# 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,411 2,911 906 3973 

150 2,411 2,902 906 3961 

180 2,411 2,907 906 3969 

210 2,411 2,902 906 3961 

240 2,411 2,912 906 3975 

360 2,411 2,898 906 3956 

480 2,411 2,906 906 3966 

600 2,411 2,907 906 3968 

820 2,411 2,902 906 3961 

1000 2,411 2,909 906 3871 

 

Tabel A.19 Data kapasitometer variasi ukuran partikel -200+230# 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,411 2,893 906 3949 

150 2,307 2,917 867 3981 

180 2,307 2,916 867 3980 

210 2,411 2,894 906 3950 
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240 2,411 2,900 906 3959 

360 2,411 2,893 906 3949 

480 2,307 2,946 867 4021 

600 2,307 2,943 867 4017 

820 2,411 2,924 906 3991 

1000 2,411 2,923 906 3990 

  

Tabel A.20 Data kapasitometer variasi ukuran partikel -230# 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,619 2,907 984 3968 

150 2,619 2,917 984 3982 

180 2,619 2,918 984 384 

210 2,723 2,890 1023 3945 

240 2,917 2,917 984 3981 

360 2,827 2,934 1063 4005 

480 2,619 2,940 984 4013 

600 2,619 2,938 984 4010 

820 2,619 2,930 984 3999 

1000 2,619 2,945 984 4020 
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Tabel A.21 Data kapasitometer variasi dosis frother 20 ppm 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,619 2,908 984 3969 

150 2,619 2,934 984 4005 

180 2,619 2,939 984 4012 

210 2,619 2,930 984 4000 

240 2,619 2,944 984 4018 

360 2,619 2,938 984 4011 

480 2,723 2,920 1023 3985 

600 2,723 2,924 1023 3991 

820 2,723 2,923 1023 3990 

1000 2,723 2,924 1023 3991 

 

Tabel A.22 Data kapasitometer variasi dosis frother 30 ppm 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi 

CR (pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,656 2,897 1453 3995 

150 2,727 2,924 1492 3991 
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180 2,727 2,924 1492 3991 

210 2,727 2,922 1492 3988 

240 2,656 2,942 1453 4016 

360 2,870 2,939 1570 4012 

480 2,941 2,940 1609 4013 

600 2,656 2,941 1453 4014 

820 2,656 2,941 1453 4014 

1000 2,656 2,939 1453 4012 

 

Tabel A.23 Data kapasitometer variasi dosis frother 40 ppm 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi 

CR (pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,619 2,910 984 3973 

150 2,723 2,928 1023 3997 

180 2,723 2,925 1023 3991 

210 2,723 2,919 1023 3985 

240 2,619 2,947 984 4023 

360 2,723 2,920 1023 3986 

480 2,723 2,924 1023 3991 

600 2,619 2,945 984 4021 

820 2,723 2,924 1023 3991 

1000 2,723 2,929 1023 3998 
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Tabel A.24 Data kapasitometer variasi dosis frother 50 ppm 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,619 2,907 984 3968 

150 2,619 2,917 984 3982 

180 2,619 2,918 984 3984 

210 2,723 2,890 1023 3945 

240 2,917 2,917 984 3981 

360 2,827 2,934 1063 4005 

480 2,619 2,940 984 4013 

600 2,619 2,938 984 4010 

820 2,619 2,930 984 3999 

1000 2,619 2,945 984 4020 

 

A.4 Grain counting  
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Gambar A.3 Citra grain counting variasi ukuran partikel -100+150# di 150 detik: 
a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.4 Citra grain counting variasi ukuran partikel -100+150# di 180 detik: 
a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.5 Citra grain counting variasi ukuran partikel -100+150# di 210 detik: 
a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.6 Citra grain counting variasi ukuran partikel -100+150# di 240 detik: 
a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.7 Citra grain counting variasi ukuran partikel -100+150# di 360 detik: 
a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.8 Citra grain counting variasi ukuran partikel -100+150# di 480 detik: 
a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.9 Citra grain counting variasi ukuran partikel -100+150# di 600 detik: 
a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.10 Citra grain counting variasi ukuran partikel -100+150# di 820 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.11 Citra grain counting variasi ukuran partikel -100+150# di 1000 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.12 Citra grain counting variasi ukuran partikel -150+200# di 150 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.13 Citra grain counting variasi ukuran partikel -150+200# di 180 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.14 Citra grain counting variasi ukuran partikel -150+200# di 210 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.15 Citra grain counting variasi ukuran partikel -150+200# di 240 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.16 Citra grain counting variasi ukuran partikel -150+200# di 360 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.17 Citra grain counting variasi ukuran partikel -150+200# di 480 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.18 Citra grain counting variasi ukuran partikel -150+200# di 600 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.19 Citra grain counting variasi ukuran partikel -150+200# di 820 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.20 Citra grain counting variasi ukuran partikel -150+200# di 1000 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 



 

78 
 

 

Gambar A.21 Citra grain counting variasi ukuran partikel -200+230# di 150 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.22 Citra grain counting variasi ukuran partikel -200+230# di 180 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 



 

79 
 

 

Gambar A.23 Citra grain counting variasi ukuran partikel -200+230# di 210 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.24 Citra grain counting variasi ukuran partikel -200+230# di 240 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.25 Citra grain counting variasi ukuran partikel -200+230# di 360 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.26 Citra grain counting variasi ukuran partikel -200+230# di 480 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.27 Citra grain counting variasi ukuran partikel -200+230# di 600 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.28 Citra grain counting variasi ukuran partikel -200+230# di 820 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.29 Citra grain counting variasi ukuran partikel -200+230# di 1000 
detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.30 Citra grain counting variasi ukuran partikel -230# di 150 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.31 Citra grain counting variasi ukuran partikel -230# di 180 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.32 Citra grain counting variasi ukuran partikel -230# di 210 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.33 Citra grain counting variasi ukuran partikel -230# di 240 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.34 Citra grain counting variasi ukuran partikel -230# di 360 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.35 Citra grain counting variasi ukuran partikel -230# di 480 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.36 Citra grain counting variasi ukuran partikel -230# di 600 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.37 Citra grain counting variasi ukuran partikel -230# di 820 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.38 Citra grain counting variasi ukuran partikel -230# di 1000 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.39 Citra grain counting variasi dosis frother 20 ppm di 150 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.40 Citra grain counting variasi dosis frother 20 ppm di 180 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.41 Citra grain counting variasi dosis frother 20 ppm di 210 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.42 Citra grain counting variasi dosis frother 20 ppm di 240 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.43 Citra grain counting variasi dosis frother 20 ppm di 360 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.44 Citra grain counting variasi dosis frother 20 ppm di 480 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.45 Citra grain counting variasi dosis frother 20 ppm di 600 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.46 Citra grain counting variasi dosis frother 20 ppm di 820 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.47 Citra grain counting variasi dosis frother 20 ppm di 1000 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.48 Citra grain counting variasi dosis frother 30 ppm di 150 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.49 Citra grain counting variasi dosis frother 30 ppm di 180 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.50 Citra grain counting variasi dosis frother 30 ppm di 210 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.51 Citra grain counting variasi dosis frother 30 ppm di 240 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.52 Citra grain counting variasi dosis frother 30 ppm di 360 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.53 Citra grain counting variasi dosis frother 30 ppm di 480 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.54 Citra grain counting variasi dosis frother 30 ppm di 600 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.55 Citra grain counting variasi dosis frother 30 ppm di 820 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.56 Citra grain counting variasi dosis frother 30 ppm di 1000 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.57 Citra grain counting variasi dosis frother 40 ppm di 150 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.58 Citra grain counting variasi dosis frother 40 ppm di 180 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.59 Citra grain counting variasi dosis frother 40 ppm di 210 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.60 Citra grain counting variasi dosis frother 40 ppm di 240 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.61 Citra grain counting variasi dosis frother 40 ppm di 360 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.62 Citra grain counting variasi dosis frother 40 ppm di 480 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.63 Citra grain counting variasi dosis frother 40 ppm di 600 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.64 Citra grain counting variasi dosis frother 40 ppm di 820 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.65 Citra grain  counting variasi dosis frother 50 ppm di 150 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.66 Citra grain counting variasi dosis frother 50 ppm di 180 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.67 Citra grain counting variasi dosis frother 50 ppm di 210 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.68 Citra grain counting variasi dosis frother 50 ppm di 240 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.69 Citra grain counting variasi dosis frother 50 ppm di 360 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.70 Citra grain counting variasi dosis frother 50 ppm di 480 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.71 Citra grain counting variasi dosis frother 50 ppm di 600 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.72 Citra grain counting variasi dosis frother 50 ppm di 840 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.73 Citra grain counting variasi dosis frother 50 ppm di 1000 detik: a) 
kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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LAMPIRAN B 

CONTOH PERHITUNGAN 

 

 

B.1 Perhitungan Kadar Feed 

Dalam penelitian ini, silikon karbida yang digunakan adalah 20% dari total 

umpan yang berjumlah 100 g. Perhitungan massa silikon karbida dan kuarsa yaitu: 

Kadar SiC= Massa SiC
Massa Feed

×100% ………………. (B.1) 

20% = Massa SiC
100 gram

×100%  

Massa SiC = 20% × 100 gram
100%

=20	gram  

Massa kuarsa = Massa feed  - massa SiC……….(B.2) 

Massa kuarsa = 100 gram – 20 gram = 80 gram 

 

B.2 Perhitungan Persen Solid 

 Persentase solid yang digunakan pada penelitian ini adalah 20 %. Jumlah 

massa feed yang digunakan 100 gram, maka air yang dibutuhkan yaitu: 

% solid = Massa padatan
Massa padatan + massa air

×100% …… (B.3) 

20% = 100 gram
100 gram + massa air

×100%  

100 gram + massa air = 100 gram
20%

×100%   

100 gram + massa air = 500 gram 

Massa air = 500 – 100 gram = 400 gram 

Massa air = 400 gram = 400 mL 
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 B.3 Perhitungan Dosis Frother 

 Massa campuran antara feed dan air yang digunakan pada penelitian ini 

adalah 500 gram. Variasi dosis frother yang digunakan adalah 20 ppm, 30 ppm, 40 

ppm, dan 50 ppm, sehingga massa frother yang digunakan dapat dihitung dengan 

persamaan: 

 Dosis ppm = Massa frother
Massa padatan campuran

×106 .…….…(B.4) 

20 ppm = Massa kolektor
500 gram

×106  

Massa frother = 10 × 500 gram
106

= 0,01 gram  

 

Tabel B.1 Penentuan dosis frother  

Massa Campuran (gram) Dosis Frother (ppm) Massa Frother (gram) 

500 

20 0,01 

30 0,015 

40 0,02 

50 0,025 

 

B.4 Perhitungan Dosis Kolektor 

 Dosis kolektor yang digunakan pada penelitian ini adalah 40 ppm, sehingga 

massa kolektor yang digunakan dapat dihitung dengan persamaan: 

 Dosis ppm = Massa kolektor
Massa padatan campuran

×106 .…… (B.5) 

40 ppm = Massa kolektor
500 gram

×106  
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Massa kolektor = 40 × 500 gram
106

= 0,02 gram  

 

 B.5  Perhitungan Kadar Konsentrat 

 Perhitungan kadar konsentrat dilakukan dengan mengganti massa partikel 

SiC dan SiO2 menjadi massa jenis dalam rumus konsentrat. Volume keduanya 

dianggap sama karena berada pada fraksi ukuran yang sama. Perhitungan ini 

dilakukan untuk setiap waktu interval dengan persamaan: 

Kadar SiC pada konsentrat = 

Jumlah partikel SiC×ρ SiC
(Jumlah partikel SiC×ρ SiC)+(Jumlah partikel SiO2×ρSiO2)

×100% …………………………(B.6) 

Kadar SiO2 pada konsentrat = 

Jumlah partikel SiC×ρ SiC
(Jumlah partikel SiC×ρ SiC)+(Jumlah partikel SiO2×ρSiO2)

×100% …………………………(B.7) 

 

Berikut merupakan contoh hasil dari perhitungan untuk kadar partikel 

variasi dosis frother 40 ppm di waktu 150 detik. 

Kadar SiC pada konsentrat = 171,60 × 3,21 g/mL
(171,60 × 3,21 g/mL)+(490,40 × 2,65 g/mL)

×100%   

Kadar SiC pada konsentrat = 29,77% 

 

Kadar SiO2 pada konsentrat = 490,40 × 2,65
(171,60 × 3,21 g/mL)+(490,40 × 2,65 g/mL)

×100%  

Kadar SiO2 pada konsentrat = 70,23% 

Tabel B.2 Kadar SiC dan SiO2 pada variasi ukuran partikel -100+150# 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 
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0 0 0 

150 3,68 96,32 

180 6,53 93,47 

210 5,99 94,01 

240 5,65 94,35 

360 5,27 94,73 

480 3,41 96,59 

600 3,40 96,60 

820 7,04 92,96 

1000 8,70 91,30 

 

Tabel B.3 Kadar SiC dan SiO2 pada variasi ukuran partikel -150+200# 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 4,67 95,33 

180 7,11 92,89 

210 3,34 96,66 

240 8,07 91,93 

360 10,21 89,79 

480 11,41 88,59 

600 15,31 84,69 

820 7,00 93,00 

1000 10,34 89,66 
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Tabel B.4 Kadar SiC dan SiO2 pada variasi ukuran partikel -200+230# 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 21,33 78,67 

180 15,74 84,26 

210 13,98 86,02 

240 19,34 80,66 

360 15,67 84,33 

480 9,48 90,52 

600 15,76 84,24 

820 10,47 89,53 

1000 12,55 87,45 

 

Tabel B.5 Kadar SiC dan SiO2 pada variasi ukuran partikel -230# 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 15,12 84,88 

180 31,06 68,94 

210 14,69 85,31 

240 18,74 81,26 

360 16,86 83,14 

480 29,76 70,24 

600 3,06 96,94 
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820 5,69 94,31 

1000 9,79 90,21 

 

Tabel B.6 Kadar SiC dan SiO2 pada variasi dosis frother 20 ppm 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 20,88 79,12 

180 36,15 63,85 

210 21,66 78,34 

240 23,81 76,19 

360 46,59 53,41 

480 21,41 78,59 

600 18,37 81,63 

820 19,85 80,15 

1000 19,46 80,54 

 

Tabel B.7 Kadar SiC dan SiO2 pada variasi dosis frother 30 ppm 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 30,40 69,60 

180 29,75 70,25 

210 30,71 69,29 

240 31,68 68,32 
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360 23,16 76,84 

480 40,47 59,53 

600 44,57 55,43 

820 25,99 74,01 

1000 16,71 83,29 

 

Tabel B.8 Kadar SiC dan SiO2 pada variasi dosis frother 40 ppm 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 29,77 70,23 

180 23,04 76,96 

210 44,34 55,66 

240 28,80 71,20 

360 36,96 63,04 

480 34,83 65,17 

600 25,61 74,39 

820 39,73 60,27 

1000 0,00 0,00 

 

Tabel B.9 Kadar SiC dan SiO2 pada variasi dosis frother 50 ppm 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 15,12 84,88 
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180 31,06 68,94 

210 14,69 85,31 

240 18,74 81,26 

360 16,86 83,14 

480 29,76 70,24 

600 3,06 96,94 

820 5,69 94,31 

1000 9,79 90,21 

 

B.6 Perhitungan Recovery dan Kumulatif Recovery 

 Perhitungan recovery dan kumulatif recovery dilakukan setelah massa dan 

kadar dari silikon karbida pada konsentrat diketahui. Untuk menghitung recovery, 

menggunakan Persamaan B.8, dan untuk menghitung kumulatif recovery 

menggunakan Persamaan B.9 berikut: 

% Recovery  = Kadar SiC × Massa konsentrat
Kadar feed × Massa feed

×100% ……………...…………………(B.8)  

% Kumulatif recovery = % recovery + % recovery sebelumnya ……………….(B.9) 

Berikut merupakan contoh hasil dari perhitungan recovery untuk kadar 

partikel variasi dosis frother 40 ppm di waktu 150 detik. 

% Recovery = 29,77 % × 36,54 gram
20 % × 100 gram

×100%  

% Recovery = 54,39% 
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Tabel B.10 Recovery dan Kumulatif Recovery Variasi Ukuran Partikel -100+150# 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 1,142 1 

180 0,245 1 

210 0,183 2 

240 0,110 2 

360 0,295 2 

480 0,083 2 

600 0,020 2 

820 0,056 2 

1000 0,035 2,17 

 

Tabel B.11 Recovery dan Kumulatif Recovery Variasi Ukuran Partikel -150+200# 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 0,292 0,29 

180 0,494 0,79 

210 0,082 0,87 

240 0,303 1,17 

360 0,449 1,62 

480 0,200 1,82 

600 0,268 2,09 
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820 0,151 2,24 

1000 0,114 2,35 

 

Tabel B.12 Recovery dan Kumulatif Recovery Variasi Ukuran Partikel -200+230# 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 0,906 0,91 

180 0,874 1,78 

210 0,426 2,21 

240 1,624 3,83 

360 3,118 6,95 

480 0,493 7,44 

600 1,056 8,50 

820 0,136 8,63 

1000 0,295 8,93 

 

Tabel B.13 Recovery dan Kumulatif Recovery Variasi Ukuran Partikel -230# 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 11,44 11,44 

180 7,41 18,85 

210 6,32 25,16 

240 5,27 30,44 
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360 0,55 30,98 

480 0,06 31,04 

600 0,01 31,06 

820 0,17 31,22 

1000 0,05 31,28 

 

Tabel B.14 Recovery dan Kumulatif Recovery Variasi Dosis Frother 20 ppm 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 4,39 4,39 

180 1,68 6,07 

210 1,78 7,84 

240 2,05 9,89 

360 10,93 20,81 

480 1,06 21,87 

600 0,32 22,20 

820 0,41 22,60 

1000 0,11 22,71 

 

Tabel B.15 Recovery dan Kumulatif Recovery Variasi Dosis Frother 30 ppm 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 28,86 28,86 
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180 6,08 34,95 

210 3,49 38,43 

240 4,74 43,17 

360 12,84 56,01 

480 7,43 63,44 

600 1,94 65,38 

820 0,39 65,77 

1000 0,49 66,26 

 

Tabel B.16 Recovery dan Kumulatif Recovery Variasi Dosis Frother 40 ppm 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 54,39 54,39 

180 10,75 65,13 

210 5,99 71,12 

240 5,17 76,29 

360 1,81 78,10 

480 1,38 79,48 

600 0,54 80,02 

820 0,24 80,25 

1000 0 22,71 
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Tabel B.17 Recovery dan Kumulatif Recovery Variasi Dosis Frother 50 ppm 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 11,44 11,44 

180 7,41 18,85 

210 6,32 25,16 

240 5,27 30,44 

360 0,55 30,98 

480 0,06 31,04 

600 0,01 31,06 

820 0,17 31,22 

1000 0,05 31,28 
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LAMPIRAN C 

GRAIN COUNTING 

 

 

C.1 Analisis Grain Counting Menggunakan ImageJ 1.53t 

 Untuk menghitung jumlah partikel pada sampel konsentrat di setiap kotak 

selama proses grain counting, digunakan software ImageJ 1.53t. Proses ini 

dilakukan melalui beberapa tahap. Tahap pertama adalah membuka ImageJ 1.53t, 

lalu memilih menu “File” > “Open” untuk membuka citra yang akan dianalisis 

(Gambar C.1). Selanjutnya, pilih menu “Image” > “Adjust” > “Color Threshold…” 

untuk mengatur parameter seperti Hue, Saturation, dan Brightness sesuai dengan 

karakteristik warna atau tingkat kecerahan partikel yang akan dihitung (Gambar 

C.2). Setelah itu, pilih menu “Process” > “Binary” > “Make Binary” untuk 

mengubah citra menjadi hitam-putih tanpa warna abu-abu atau warna lainnya 

(Gambar C.3). Hal ini bertujuan agar objek utama (putih) dan latar belakang (hitam) 

terlihat jelas perbedaannya, sebagaimana ditunjukkan pada Gambar C.4. Tahapan 

setelah itu dilakukan pada menu “Binary” dengan opsi yang berbeda. Yang pertama, 

pilih “Convert to Mask” untuk menyorot atau menandai area yang difokuskan 

(Gambar C.5), ke dua pilih “Fill Holes” untuk mengisi area yang kosong atau 

lubang-lubang keci (Gambar C.6), dan yang terakhir adalah menu “Watershed” 

yang berguna untuk memisahkan objek atau partikel yang terdeteksi saling 

menempel (Gambar C.7). Pilih menu “Analyze” > “Analyze Particles…” untuk 

menganalisis jumlah partikel pada citra. Atur opsi “Show” dari “Nothing” ke 
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“Overlay Masks” agar mask hasil analisis biner (pada menu “Binary”) sebelumnya 

dapat ditampilkan. Pengaturan ini membantu memvisualisasikan objek yang telah 

dihitung atau dianalisis oleh ImageJ (Gambar C.8 dan C.9). Hasil analisis (Gambar 

C.10) akan menampilkan jumlah partikel yang dihitung dalam bentuk angka. 

 

Gambar C.1 Menu “Open” pada “File” Untuk Membuka Citra  

 

 

Gambar C.2 Menu “Color Threshold…” pada “Adjust” 
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Gambar C.3 Pengaruran “Threshold Color” 

 

 

Gambar C.4 a) Menu “Make Binary” pada “Binary”, b) Hasil dari “Make 

Binary” 
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Gambar C.5 Menu “Convert to Mask” pada “Binary” 

 

 

Gambar C.6 Menu “Fill Holes” pada “Binary” 
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Gambar C.7 Menu “Watershed” pada “Binary” 

 

 

Gambar C.8 Menu “Analyze Particles…” pada “Analyze” 
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Gambar C.9 Pengaturan pada “Analyze Particles” 

 

 

Gambar C.10 Hasil Akhir Analisis Grain Counting dengan ImageJ 
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LAMPIRAN D 

ANALISIS POLA XRD 

 

 

D.1 Analisis Pola XRD Menggunakan Profex 5.2.5 

Setelah mendapat pola difraksi XRD sampel SiC, analilisis dilakukan 

menggunakan software Profex 5.2.5. Pertama, buka raw file pola XRD di Profex 

dengan memilih menu “File” > “Open Raw Scan File …” dan pilih file pola XRD 

yang akan dianalisis (Gambar D.1). Pada kolom “Search/Match Phases”, terdapat 

menu “Phases”, lalu pilih SiC dan BGM untuk mengklasifikasikan puncak-puncak 

dengan data base nya (Gambar D.2). Selanjutnya pada menu “Restrictions”, pilih 

Si dan C sebagai pembatas jenis unsur yang akan dianalisis (Gambar D.3). Lalu 

pada “Controls” instrument yang dipilih disesuaikan dengan konfigurasi pengujian 

XRD (Gambar D.4). Setelah itu, pilh menu “Run” > “Run Search-Match” untuk 

mulai menganalisis. Setelah proses selesai, tampilan Profex akan seperti pada 

Gambar D.5. Proses Search-Match diulang dengan menandai fasa yang memiliki 

nilai FoM tertinggi menggunakan tanda panah ke bawah pada kolom “Result”. 

Proses ini berlanjut hingga fasa yang ditampilkan menunjukkan kecocokan yang 

rendah dengan database, ditandai dengan nilai FoM yang tidak lagi berwarna hijau 

(Gambar D.6). Terakhir merupakan “Refinement” dengan memilih menu 

“Add/remove phase” untuk mendapat hasil seperti Gambar D.7 dan tabel dari 

chemical compositions nya. 
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Gambar D.1 Menu “Open Raw Scan File…” pada “File” 

 

 

Gambar D.2 “Phases” pada Kolom “Search/Match Phases” 

 

 

Gambar D.3 “Restrictions” pada Kolom “Search/Match Phases” 
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Gambar D.4 “Controls” pada Kolom “Search/Match Phases” 

 

 

Gambar D.5 Menu “Run Search-Match” pada “Run” 
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Gambar D.6 “Results” pada kolom “Search/Match Phases” 

 

 

Gambar D.7 Hasil Akhir dari Analisis Pola XRD 

 

 



 

131 
 

 

 

 
 

 

 
 

 
 

 

 
 

 

LAMPIRAN E 
GAMBAR ALAT DAN BAHAN 
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LAMPIRAN E 

GAMBAR ALAT DAN BAHAN 

 

 

E.1 Gambar Alat 

 

Gambar E.1 Chopper 

 

Gambar E.2 Ember 

 

Gambar E.3 Flowmeter 

 

Gambar E.4 Gelas kimia 500 mL 

 

Gambar E.5 Kapasitometer 

 

Gambar E.6 Kolom flotasi 
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Gambar E.7 Kompresor udara 

 

Gambar E.8 Kabel konektor 

 

Gambar E.9 Kaca arloji 

 

Gambar E.10 Kaca pembesar 

 

Gambar E.11 Hand mixer  

 

Gambar E.12 Nampan Logam  

 

Gambar E.13 Neraca digital 

 

Gambar E.14 Oven 
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Gambar E.15 Screen 100#, 150#, 

200#, dan 2230# 

 

Gambar E.16 Stabilizer 

 

Gambar E.17 Termometer digital 

 

Gambar E.18 Water sprayer 

 

 

E.2 Gambar Bahan 

 

Gambar E.19 Frother pine oil 

 

Gambar E.20 Kolektor Methyl ester 

sulfonate 
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Gambar E.21 Kuarsa (SiO2) 

 

Gambar E.22 SiC 

 


